
 

 

ELEMENTE INTRODUCTIVE PRIVIND MODELAREA CU 
ELEMENTE FINITE UTILIZÂND SOFT-UL CATIA 

 
 
 Modelarea cu metoda elementelor finite a sistemelor mecanice, utilzând soft-ul CATIA 
V5R10 sau versiuni evoluate (soft care este utilizat pentru modelarea elementelor, 

subansamblelor şi structurilor din prezenta lucrare), este caracterizată de o serie de avantaje 

care se referă, în principal, la: 
- modelarea unor domenii cu geometrie complexă; 

- modelarea ansamblelor şi subansamblelor; 

- flexibilitate; 

- modelarea unor categorii relativ mari de materiale existente în biblioteca soft-ului; 
- modelarea materialelor cu comportare neliniară; 

- modelarea domeniilor unidimensionale, bidimensionale şi tridimensionale; 

- modelarea legăturilor fixe şi mobile dintre elementele componente ale ansamblelor şi 
subansamblelor; 

- modelarea legăturilor cu baza (partea fixă); 

- modelarea încărcărilor de tip: forţe concentrate sau distribuite; momente; acceleraţii; 

mase concentrate sau distribuite; deplasări impuse; acceleraţii; temperaturi; 
- posibilitatea verificării întocmirii corecte a modelului; 

- posibilităţi de analiză statică, a modurilor şi frecvenţelor proprii de vibraţie şi de 

analiză termică; 
- viteze relativ mari de analiză a modelului; 

- posibiltăţi de vizualizare a reultatelor sub formă de: câmpuri de valori în codul 

culorilor; stări deformate şi animate; liste de valori; grafice. 

Analiza comparativă a rezultatelor obţinute în urma rezolvării modelelor întocmite în soft-
urile care au la bază metoda elementelor finite (MEF) gen CATIA, PATRAN/NASTRAN şi 

NASTRAN for Windows au evidenţiat diferenţe nesemnificiative (sub 2%), ceea ce confirmă 

posibilitzatea utilizării soft-ului CATIA pentru modelarea cu elemente finite. 

 Modelarea cu elemente finite prin intermediul soft-ului CATIA presupune, ca şi în cazul 
utilizării celorlate soft-uri care au la bază MEF, parcugerea unor etape specifice, prezentate în 

tabelul 1 [1, 7, 14, 15, 20]. În continuare se prezintă comenzile utilizate în cadrul prezentei 

lucrări. 
 Comenzile generale de vizualizare sunt: 

 (Fit All In) ≈ vizualizare a întregului model prin autoscalare. 

 (Pan) ≈ vizualizare a modelului prin translaţie. 

 (Rotate) ≈ vizualizare a modelului prin rotaţie. 

 (Zoom In) ≈ vizualizare a modelului prin mărire. 
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 (Zoom Out) ≈ vizualizare a modelului prin micşorare. 

 Vizualizarea comenzilor “ascunse” se realizează prin parcurgerea comenzilor 

View ⇒ Toolbars ⇒ Customize... ⇒ Commands ⇒ Categories/All Commands, 

Commands, se selectează comanda dorită ⇒ click mouse stânga şi se plasează comanda în 

bara de comenzi ⇒ se eliberează mouse-ul. 

Tabelul 1 

Modelarea domeniului geometric 

Modelarea materialului 

Generarea structurii 

cu elemente finite 

- discretizare; 

- modelare proprietăţi; 
- obţinere elemente finite speciale. 

Modelarea 
constrângerilor 

- modelare legături cu elementele 

  adiacente; 
- modelare legături cu baza. 

Modelarea încărcărilor 

PREPROCESAREA 

Verificarea modelului cu elemente finite 

REZOLVAREA MODELULUI CU ELEMENTE FINITE 
Vizualizarea şi studiul rezultatelor 

POSTPROCESAREA 
Optimizarea modelului 

 

 Modelarea domeniului geometric al problemei constă în descrierea formei şi 

dimensiunilor pieselor sau elementelor componente ale ansamblelor şi subansamblelor care se 
modelează cu metoda elementelor finite. 

 În soft-ul CATIA, descrierea profilelor plane care stau la baza generării elementelor 

tridimensionale se realizează în modulul Sketcher, prin parcurgerea succesiunilor de comenzi 

Start ⇒ Mechanical Design ⇒ Part Design ⇒  (Sketcher). 

 Comenzile din modulul Sketcher, utilizate în prezenta lucrare, se referă la: 

 (Snap to Point) ≈ opţiunea snap de poziţionare a mouse-ului la intersecţia liniilor din 

caroiaj. 

 (Construction/Standard Element) ≈ se desenează/transformă linii sau curbe ajutătoare, 

fără a fi considerate linii de contur. 

 (Geometrical Constraints) ≈ se activează în cazul introducerii constrângerilor 

geometrice (dimensiuni sau condiţii de dependenţă – coincidenţă, paralelism, 

perpendicularitate, concentricitate etc.). 

 (Profile) ≈ se desenează conturul închis. 

 (Rectangle) ≈ se desenează un dreptunghi. 

 (Hexagon) ≈ se desenează un hexagon. 

 (Circle) ≈ se desenează un cerc, prin metoda centru - rază. 
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 (Line) ≈ se desenează o linie. 

 (Point by Clicking) ≈ se desenează un punct, prin metoda click. 

 (Intersection Point) ≈ se desenează un punct la intersecţia a două linii. 

 (Corner) ≈ se generează o racordare. 

 (Chamfer) ≈ se generează o teşitură. 

 (Quick Trim) ≈ ştergere linii între puncte de intersecţie. 

 (Symmetry) ≈ generarea entităţilor simetrice faţă de o axă. 

 (Translate) ≈ copierea prin translaţie după o axă. 

 (Rotate) ≈ copierea prin rotaţia în jurul unui punct. 

 (Constraint) ≈ se definesc dimensiuni tip lungimi, distanţe, unghiuri, prin selectarea 
entităţii geometrice şi a comenzii. 

 (Constraints Defined in Dialog Box) ≈ se definesc cosntrângeri geometrice tip condiţii 

de dependenţă (distanţă, lungime, unghi, rază/diametru, simetrie, puncte de mijloc, puncte 

echidistante, fixare, coincidenţă, concentricitate, tangenţă, paralelism, perpendicularitate, 

orizontalitate, verticalitate), prin selectarea a două entităţi geometrice şi a comenzii. 

 (Measure Between) ≈ măsurare distanţă între două entităţi prin selectarea a două 

entităţi geometrice şi a comenzii. 

 (Measure) ≈ măsurare dimensiuni prin selectarea entităţii geometrice şi a comenzii. 

 (Exit Workbench) ≈ ieşire din modulul Sketcher – se intră în modulul Part. 
 Descrierea elementelor tridimensionale, se realizează în modulul Pad prin parcurgerea 

succesiunilor de comenzi 

Start ⇒ Mechanical Design ⇒ Part Design. 

 Comenzile din modulul Pad, utilizate în prezenta lucrare, se referă la: 

 (Point) ≈ creare punct. 

 (Line) ≈ creare linie. 

 (Polyline) ≈ creare polilinie. 

 (Extrude Surface) ≈ generarea suprafeţei prin extrudarea unei linii. 

 (Pad) ≈ extrudare după o direcţie. 

 (Shaft) ≈ rotaţie după o direcţie. 

 (Pocket) ≈ generare gol prin “extragere” de material a unui profil închis. 

 (Hole) ≈ generare gaură. 

 (Rib) ≈ extrudare după o curbă. 

 (Slot) ≈ generare gol prin “extragere” de material a unui profil închis după o curbă. 

 (Helix) ≈ generare spirală spaţială. 
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 (Spiral) ≈ generare spirală plană. 

 (Edge Fillet) ≈ generare racordare. 

 (Chamfer) ≈ generare teşitură. 

 (Translation) ≈ translaţia după o direcţie a unei entităţi. 

 (Rotation) ≈ rotaţia după o direcţie a a unei entităţi. 

 (Symmetry) ≈ generarea a unei entităţi simetrice faţă de o axă. 

 (Mirror) ≈ oglindirea a unei entităţi faţă de un plan. 

 (Rectangular Patern) ≈ copierea a unei entităţi prin dispunere matriceală. 

 (Circular Patern) ≈ copierea a unei entităţi prin dispunere circulară. 

 (Measure Between) ≈ măsurare distanţă între două entităţi prin selectarea a două 
entităţi geometrice şi a comenzii. 

 (Measure) ≈ măsurare dimensiuni prin selectarea entităţii geometrice şi a comenzii. 

 (Insert ⇒ Axis System) ≈ crearea unui sistem de referinţă local. 

 Descrierea ansamblelor şi subansamblelor se realizează în modulul Assembly Design prin 

parcurgerea succesiunilor de comenzi 

Start ⇒ Mechanical Design ⇒ Assembly Design. 

 Comenzile din modulul Assembly Design, utilizate în prezenta lucrare, se referă la: 

 (Existing Component) ≈ inserarea pieselor de tip Part prin activarea specificaţiei 

Product din arborescenţă. 

 (Manipulate) ≈ deplasarea corpurilor prin translaţie sau rotaţie; activarea specificaţiei 

With respect to constraints presupune deplasarea corpurilor cu păstrarea constrângerilor 

geometrice. 

 (Coincidence) ≈ creare constrângeri de tip coincidenţă între: puncte, linii, plane, 

suprafeţe. 

 (Contact) ≈ creare constrângeri de tip contact între suprafeţe. 

 (Offset Constraint) ≈ creare constrângeri de tip distanţă. 

 (Angle Constraint) ≈ creare constrângeri de tip unghi; se por activa specificaţiile de tip 

paralelism sau perpendicularitate. 

 (Fix Component) ≈ creare constrângeri de tip fixare. 

 (Measure Between) ≈ măsurare distanţă între două corpuri prin selectarea a două 
entităţi geometrice şi a comenzii. 

 (Measure) ≈ măsurare dimensiuni prin selectarea entităţii geometrice şi a comenzii. 

 Modelarea materialului se poate realiza în modulul Part sau în modulul Assembly 
Design prin activarea comenzii 



Elemente introductive privind modelarea cu elemente finite utilizând soft-ul CATIA 15 

 
 

Fig.2 
 

 
 

Fig.3 
 

 (Apply Material) ≈ identificarea materialului de tip: material de construcţie, textile, 

metale, materiale speciale (plastic, sticlă, cauciuc, apă), rocă, lemn ⇒ selectare material ⇒ 

selectare Part ⇒ Apply Material ⇒ OK. Prin efectuarea unui dublu click pe un material se 

vizualizează şi se pot modifica parametrii mecanici şi termici ai materialului: modulul lui 

Young, coeficientul lui Poisson, densitatea, coeficientul de dilataţie termică, limita de 

curgere (fig.1). 

 
 

Fig.1 

 

 Generarea modelului cu elemente finite, în soft-ul CATIA, în funcţie de tipul analizei, se 
realizează în modulul Generative Structural Analysis 

prin parcurgerea succesiunii de comenzi 

 - pentru analiza statică:  

Start ⇒ Analysis & Simulation ⇒ Generative 

Structural Analysis ⇒ New Analysis Case Static 
Analysis, OK (fig.2); 

 - pentru analiza modurilor şi frecvenţelor proprii:  

Start ⇒ Analysis & Simulation ⇒ Generative 

Structural Analysis ⇒ New Analysis Case Free 
Frequency Analysis, OK (fig.3). 

Generarea structurii cu elemente finite se realizează în 
două etape: 

- etapa discretizării (alegerea tipului de elemente 

finite, a mărimii acestora şi a abaterii maxime 
admise); 

- etapa de introducere a proprietăţilor elementelor 

finite. 
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Fig.5 
 

 

Fig.6 
 

 
 

Fig.7 
 

 Discretizarea se realizează printr-una din comenzile prezentate în continuare, în funcţiue 

de tipul domeniului geometric (unidimensional, bidimensional sau tridimensional); Size se 

referă la dimensiunea elementului finit (lungimea maximă a muchiei), iar Sag la eroarea 

maximă admisă pentru modelarea geometrică. 

 (Beam Mesher) ≈ discretizare cu elemente finite de tip linie a domeniilor 

unidimensionale (fig.4).  

 (Octree Triangle Mesher) ≈ discretizare cu elemente 

finite de tip triunghi a domeniilor de tip suprafaţă; muchiile 

elementelor finite pot fi linii drepte sau parabole (fig.5).  

 (Octree Tetrahedron Mesher) ≈ selectarea domeniului 

tridimensional (fig.6). 

 Introducerea proprietăţilor elementelor finite este 

prezentată în continuare. 

 (Beam Property) ≈ selectarea domeniului 

unidimensional, discretizat (fig.7).  

 Definirea secţiunii transversale a elementelor finite de tip linie presupune alegerea formei 

secţiunii şi a caracteristicilor geometrice ale acesteia. Punctul de orientare indică orientarea 
direcţiei Y, direcţia X fiind tangentă la domeniul unidimensional (tabelul 2). 

Tabelul 2 

Secţiune Parametrii Schema de calul 

1 2 3 

Cilindrică R 
 

Tubulară 
Ri 

Ro  

Dreptunghiulară 
(Y) L 

(Z) H 
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Fig.8 
 

 

 
 

Fig.9 
 

Tabelul 2 (Continuare) 

1 2 3 

Profil dreptunghiular 

(Y) Le 

(Z) He 

(Y) Li 

(Z) Hi  

Profil U 

(Y) L 

(Z) H 

(T) T 

 

Profil I 

(Y) L 

(Tl) Tl 

(Z) H 

(Th) Th 
 

Profil T 

(Y) L 

(Tl) Tl 

(Z) H 

(Th) Th 
 

Profil X 

(Y) L 

(Tl) Tl 

(Z) H 

(Th) Th 

 

Profil oarecare 
Aria secţiunii transversale 

Caracteristici inerţiale 
- 

 

 (Shell Property) ≈ 

selectarea domeniului 

bidimensional, discretizat; se 

introduce valoarea grosimii 

elementului finit de tip triunghi 
(fig.8). 

 (Solid Property) ≈ 

selectarea domeniului 

tridimensional, discretizat (fig.9). 

 



Metoda elementelor finite. Aplicaţii 18

 

Fig.10 
 

  
 

Fig.11 
 

  
 

Fig.12 
 

  
 

Fig.13 
 

 Nivelul de eroare admis se defineşte prin comanda 

 (Adaptivity Box) ≈ definirea erorii admise 

(fig.10). 
 Observaţie: generarea structurii cu elemente 

finite, în cazul domeniilor tridimensionale, se 

realizează automat, în momentul accesării 
modulului Analysis & Simulation. 

 

 Elementele finite speciale se obţin prin 

comenzile prezentate în cpntinuare. 

 (Smooth Virtual Part) ≈ element finit 

virtual, fără masă, de tip rigid care nu rigidizează entitatea de care este ataşat; conectează 

un punct master (handler) de o 

entitate de slave (support) de tip 

muchie sau suprafaţă; transmite 

acţiuni de tip masă, constrângeri sau 

încărcări aplicate punctului master 

(fig.11). 

 (Contact Virtual Part) ≈ 

element finit virtual, fără masă, de tip 

rigid care ia în considerare rgiditatea 

de contact în elementele de legătură contact rod; conectează un punct master (handler) de o 

entitate de slave (support) 
de tip muchie sau 

suprafaţă; valoarea 

jocului din contact se 

introduce în caseta 

Clearance; transmite 

acţiuni de tip masă, 

constrângeri sau încărcări 

aplicate punctului master 

(fig.12). 

 (Rigid Virtual Part) ≈ element 

finit rigid, fără masă, care rigidizează 

entitatea de care este ataşat; 

conectează un punct master (handler) 

de o entitate de slave (support) de tip 

muchie sau suprafaţă; transmite acţiuni 

de tip masă, constrângeri sau încărcări 

aplicate punctului master (fig.13). 
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 (Rigid Spring Virtual Part) ≈ element finit elastic, fără masă, cu comportare de arc cu 

şase grade de libertate înseriat cu un element finit rigid, care rigidizează entitatea de care 

este ataşat; conectează un punct master (handler) de o entitate de slave (support) de tip 

muchie sau suprafaţă; transmite acţiuni de tip masă, constrângeri sau încărcări aplicate 

punctului master; valorile rigidităţilor de translaţie şi rotaţie după cele trei axe se introduc în 

casetele Translation Stiffness şi, respectiv, Rotation Stiffenss (fig.14). 

 

   

   
Fig.14      Fig.15 

 

 (Smooth Spring Virtual Part) ≈ element finit elastic, fără masă, cu comportare de arc 

cu şase grade de libertate înseriat cu un element finit care nu rigidizează entitatea de care 

este ataşat; conectează un punct master (handler) de o entitate de slave (support) de tip 

muchie sau suprafaţă; transmite acţiuni de tip masă, constrângeri sau încărcări aplicate 

punctului master; valorile rigidităţilor de translaţie şi rotaţie după cele trei axe se introduc în 

casetele Translation Stiffness şi, respectiv, Rotation Stiffenss (fig.15). 

 

 Modelarea constrângerilor se realizează prin: 
- modelarea legăturilor cu elementele adiacente; 

- modelarea legăturilor cu baza (partea fixă). 
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Fig.16 
 

 

Fig.17 
 

 
 

Fig.18 
 

 
 

Fig.19 
 

 Modelarea legăturilor cu elementele adiacente este prezentată în continuare. 

 (Spot Welding Connection) ≈ element finit ce materializează o legătură fixă de tip 

sudură prin puncte; se 

asociază unui suport 

constrângere de asamblare 

de tip Welding Analysis 

Connections; tipul 

cosntrângerii poate fi: 

rigidă, rigid înseriat cu 

arcuri cu şase grade de 

libertate (se introduc 

rigidităţile de translaţie şi 

rotaţie după cele trei axe), arc cu şase grade de libertate (se introduc rigidităţile de translaţie 

şi rotaţie după cele trei axe) înseriat cu elemente 

rigide (fig.16). 

 (Seam Weld Connection) ≈ element finit ce 

materializează o legătură fixă de tip sudură continuă; 

se asociază unei constrângeri de asamblare de tip 

Analysis Seam Weld; se introduce grosimea sudurii 

(Thickness) (fig.17). 

 (Bolt Tightening Connection) ≈ element 

finit ce materializează o legătură fixă de tip 

asamblare prin şurub, care se asociază unei 

constrângeri de tip coincidenţă (Coincidence); 

valoarea forţei de prestrângere se introduce în 

caseta Tightening force; sensul forţelor din 

asamblare poate fi una spre cealalată (Same) 

sau în sensuri diferite (Opposite); ţine seama 

de elasticitatea asamblării (fig.18). 

 (Pressure Fitting Connection) ≈ element 

finit ce materializează o legătură fixă de tip 

asamblare presată care se asociază unei 

constrângeri de tip coincidenţă (Coincidence) sau 

contact (Contact); valoarea jocului din asamblare 

se introduce în caseta Overlap (valoarea negativă 

se referă la asamblarea cu joc, iar cea negativă la 

asamnblarea presată); ţine seama de elasticitatea 

elementelor asamblate (fig.19). 
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Fig.20 
 

 
 

Fig.21 

 

 
 

Fig.22 
 

 (Virtual Bolt Tightening Connection) ≈ element finit ce materializează o legătură fixă 

de tip asamblare prin şurub cu tija rigidă, care se asociază unei constrângeri de tip 

coincidenţă (Coincidence); valoarea forţei de prestrângere se introduce în caseta 

Tightening force; ţine seama de elasticitatea asamblării doar în plan perpendicular pe axa 

suprafeţelor coincidente (din acest motiv se utilizează, cu precădere, în studiul asamblărilor 

prin şuruburi solicitate transversal) (fig.20). 

 (Virtual Spring Bolt Tightening Connection) ≈ element finit ce materializează o 

legătură fixă de tip asamblare prin şurub cu tija elastică, care se asociază unei constrângeri 

de tip coincidenţă (Coincidence); valoarea forţei de prestrângere se introduce în caseta 

Tightening force; se introduc valorile rigidităţii tijei şurubului după cele trei axe (translaţii 

şi rotaţii); ţine seama de elasticitatea asamblării doar în plan perpendicular pe axa 

suprafeţelor coincidente (din acest motiv se utilizează, cu precădere, în studiul asamblărilor 

prin şuruburi solicitate transversal) (fig.21). 
 

 

 

 
 

 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 

 
 

 

 (Rigid Connection) ≈ element finit ce materializează o legătură fixă şi rigidă între două 

corpuri, după o frontieră comună; rigidizează local frontiera comună, fără a ţine seama de 

elasticitatea acesteia; se asociază unei constrângeri de tip coincidenţă (Coincidence), unghi 

(Angle) sau distanţă (Offset); direcţiile de rigidizare (de translaţie sau rotaţie după cele trei 
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Fig.23 
 

 

Fig.24 
 

 

Fig.25 
 

 

Fig.26 
 

axe) se setează în fereastra de dialog (fig.22). 

 (Smooth Connection) ≈ element finit ce materializează o legătură fixă şi elastică între 

două corpuri, după o frontieră comună; ţine seama de elasticitatea locală a frontierei 

comune; se asociază unei constrângeri de tip coincidenţă 

(Coincidence), unghi (Angle) sau distanţă (Offset); 
direcţiile de mişcare (de translaţie sau rotaţie după cele trei 

axe) se setează în fereastra de dialog (fig.23). 

 (Slider Connection) ≈ 

element finit ce materializează 

o legătură mobilă între două 

corpuri constrânse la o 

mişcare relativă de translaţie 

într-un plan tangent la 

frontiera lor comună; ţine 

seama de elasticitatea locală 

a frontierei comune; se asociază unei constrângeri de tip 

coincidenţă (Coincidence) sau contact (Contact) (fig.24). 

 (Contact Connection) ≈ element finit ce materializează 

o legătură mobilă, de 

contact, între două 

corpuri, cu posibilitate 

de mişcare relativă, în 

funcţie de valorea 

jocului; valoarea 

jocului se introduce în 

caseta Clearance (o 

valoare pozitivă 

presupune existenţa unei distanţe între corpuri, iar o valoare negativă – existenţa unei 

presări iniţiale între corpuri, soft-ul, prin analiză, nepermiţând interpenetrarea); ţine seama 

de elasticitatea locală de contact; se asociază unei constrângeri de tip coincidenţă 

(Coincidence) sau contact (Contact) (fig.25). 

 (Fastened Connection) ≈ element finit ce materializează o 

legătură fixă între două corpuri, fără posibilitate de mişcare 

relativă; ţine seama de elasticitatea locală de contact; se 

asociază unei constrângeri de tip coincidenţă (Coincidence) 

sau contact (Contact) (fig.26). 

 (Fastened Spring Connection) ≈ element finit ce 

materializează o legătură fixă şi elastică între două corpuri, de tip asamblare fixă cu arc, 

fără posibilitate de mişcare relativă; ţine seama de elasticitatea locală de contact; valorile 

rigidităţii arcului se introduc în caseta de dialog, pentru cele trei axe (translaţii şi rotaţii); se 
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Fig.27 
 

asociază unei constrângeri de tip coincidenţă (Coincidence) sau contact (Contact) (fig.27). 

 (User Defined Distant Connection) ≈ element 

finit ce materializează o distanţă între două corpuri, 

cu flexibilitate mărită în alegerea carateristicilor 

legăturii (a tipului de elemente finite ce modelează 

distanţa); se asociază unei constrângeri de tip 

coincidenţă (Coincidence), unghi (Angle) sau 

distanţă (Offset) (fig.28). 

 Legătura din partea stângă (Start) se realizează 
între o suprafaţă şi un punct şi poate fi de tip: 

Smooth, Rigid, Spring and Smooth, Spring and 
Rigid, Contact and Rigid. 

 Elementul central (Middle) poate fi de tip: Rigid, 
Beam, Bolt, Spring and Rigid, Rigid and Spring, 

Spring and Beam, Beam and Spring, Bolt and 
Beam, Beam and Bolt, Bolt and Spring, Spring 
and Bolt, Spring and Rigid and Spring, Spring and 
Beam and Spring, Rigid and Spring and Rigid, 

Beam and Spring and Beam. 

 Legătura din partea dreaptă (End) se realizează 
între un punct şi o suprafaţă şi poate fi de tip: Smooth, Rigid, Smooth and Spring, Rigid 
and Spring, Rigid and Contact. 
 

 
 

Fig.28 
 

 Modelarea legăturilor cu baza este prezentată în continuare. 

 (Surface Slider) ≈ constrângere ce materializează o legătură mobilă între două corpuri, 

cu posibilitate de mişcare relativă de tip translaţie a punctelor unei suprafeţe coincidente cu 

o altă suprafaţă rigidă; se asociază unei entităţi de tip suprafaţă. Săgeţile indică mişcarea de 

translaţie anulată (fig.29). 

 



Metoda elementelor finite. Aplicaţii 24

 

   
 

Fig.29 

 (Slider) ≈ constrângere de tip cuplă prismatică cu posibilitate de mişcare relativă de tip 

translaţie a unui punct după o direcţie dată; direcţia de translaţie se precizează în casetă prin 

indicarea valorii; se asociază unui punct master (Handle) al unui element finit virtual 

(mişcarea relativă de translaţie se realizează între punctul mobil master şi un punct fix situat 

pe direcţia de mişcare). Săgeţile simple implică mişcările de translaţie anulate, iar cele 

duble, mişcările de rotaţie anulate (fig.30). 

 

  
 

Fig.30 

 (Sliding Pivot) ≈ constrângere de tip cuplă cilindrică cu posibilitate de mişcare relativă 

de tip translaţie şi rotaţie a unui punct după o direcţie dată; direcţia de roto-translaţie se 

precizează în casetă prin indicarea valorii; se asociază unui punct master al unui element 

finit virtual (mişcarea relativă de roto-translaţie se realizează între punctul mobil master şi 

un punct fix situat pe direcţia de mişcare). Săgeţile simple implică mişcările de translaţie 

anulate, iar cele duble mişcările de rotaţie anulate (fig.31). 
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Fig.31 

 (Ball Joint) ≈ constrângere de tip cuplă sferică cu posibilitate de mişcare relativă de tip 

rotaţie a unui punct după cele trei axe; se asociază unui punct master al unui element finit 

virtual (mişcarea relativă de rotaţie se realizează între punctul mobil master şi un punct fix). 

Săgeţile simple implică mişcările de translaţie anulate (fig.32). 

   
 

Fig.32 

 (Pivot) ≈ constrângere de tip cuplă de rotaţie cu posibilitate de mişcare relativă de tip 

rotaţie a unui punct după o axă; se asociază unui punct master al unui element finit virtual 

(mişcarea relativă de rotaţie se realizează între punctul mobil master şi un punct fix). Săgeţile 

simple implică mişcările de translaţie anulate, iar cele duble mişcările de rotaţie anulate 

(fig.33). 

  
 

Fig.33 
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Fig.34 
 

 
 

Fig.35 
 

 (Advanced Restraint) ≈ constrângere generală cu posibilitate de definire a mişcărilor 

anulate, prin setarea în fereastra de dialog; se asociază 

punctelor, muchiilor, feţelor sau elementelor virtuale 

(fig.34).  

 (Isostatic) ≈ 

constrângere care 

generează starea static 

determinată; se asociază 

modelului cu elemente finite 

creat (fig.35).  

 (Clamp) ≈ constrângere de tip încastrare care 

anulează toate mişcările de translaţie ale entităţilor 

cărora le este aplicată; se asociază punctelor, 

muchiilor, feţelor sau elementelor virtuale. Săgeţile 

simple implică mişcările de translaţie anulate (fig.36). 

 
 Modelarea încărcărilor se poate realiza prin 

intermediul uneia din comenzile prezentate în continuare. 

             
 

Fig.36             Fig.37 

 (Pressure) ≈ încărcare de tip presiune (forţă distribuită aplicată normal pe suprafaţă); 

prin activarea Data Mapping se pot încărca fişiere de date .txt sau .xls care conţin valorile 

presiunii distribuite neuniform; se aplică pe suprafeţe (fig.37). 

 (Distributed Force) ≈ încărcare de tip forţă rezultantă; valorile componentelor după 

cele trei axe se introduc în caseta de dialog; se aplică pe puncte, suprafeţe sau elemente 

virtuale (fig.38). 

 (Bearing Load) ≈ încărcare de tip forţă de apăsare a unui rulment pe o suprafaţă 

cilindrică; valorile componentelor după cele trei axe se introduc în caseta de dialog; 

valoarea unghiului de distribuţie a forţei se introduce în caseta Angle; direcţia de orientare a 

forţei se setează în caseta Orientation şi poate fi radială sau paralelă; legea de variaţie a 
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distribuţiei poate fi de tip parabolică, sinusoidală sau o lege definită de utilizator şi se 

defineşte în caseta Type; se aplică pe suprafeţe (fig.39). 

 

   
 

          Fig.38    Fig.39    Fig.40 

 (Moment) ≈ încărcare de tip moment rezultant; valorile componentelor după cele trei 

axe se introduc în caseta de dialog; se aplică pe puncte, suprafeţe sau elemente virtuale 
(fig.40). 

 (Imported Force) ≈ încărcare de tip forţă rezultantă ale cărei valori se importă prin 

intermediul unor fişiere de date .txt sau .xls; se aplică pe puncte, suprafeţe sau elemente 

virtuale (fig.41). 

 

   
  

    Fig.41      Fig.42  
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 (Imported Moment) ≈ încărcare de tip moment rezultant ale cărui valori se importă 

prin intermediul unor fişiere de date .txt sau .xls; se aplică pe puncte, suprafeţe sau elemente 

virtuale (fig.42). 

 (Acceleration) ≈ încărcare de tip forţe masice datorate unor câmpuri inerţiale de 

translaţie; valorile componentelor după cele trei axe se introduc în caseta de dialog; se 

aplică pe volume (fig.43). 

 (Rotation Force) ≈ încărcare de tip forţe masice datorate unor câmpuri inerţiale de 

rotaţie; în caseta de dialog se setează axa de rotaţie şi se introduc valorile vitezei şi 

acceleraţiei unghiulare; se aplică pe volume (fig.44). 
 

  
 

    Fig.43     Fig.44  

 (Line Force Density) ≈ încărcare de tip forţă distribuită pe linie; componentele forţei, 

după trei axe, se introduc în caseta de dialog; prin activarea Data Mapping se pot încărca 

fişiere de date .txt sau .xls care conţin valorile forţei distribuite neuniform; se aplică pe 

muchii (fig.45). 

 (Surface Force Density) ≈ încărcare de tip forţă distribuită pe suprafaţă; componentele 

forţei, după trei axe, se introduc în caseta de dialog; prin activarea Data Mapping se pot 

încărca fişiere de date .txt sau .xls care conţin valorile forţei distribuite neuniform; se aplică 

pe feţe (fig.46). 

 (Body Force) ≈ încărcare de tip forţă distribuită în volum; componentele forţei, după 

trei axe, se introduc în caseta de dialog; prin activarea Data Mapping se pot încărca fişiere 

de date .txt sau .xls care conţin valorile forţei distribuite neuniform; se aplică pe volume 

(fig.47). 
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          Fig.45    Fig.46    Fig.47 

 (Enforced Displacement) ≈ încărcare de tip deplasare impusă; componentele 

deplasărilor, după trei axe (translaţii sau rotaţii), se introduc în caseta de dialog; se aplică 

pe entităţi de tip constrângere (fig.48). 

 (Temperature Field) ≈ încărcare de tip temperatură ale cărei valori, măsurate în grade 

Kelvin (0 
o
C = 273,15 K), se introduc în caseta de dialog; prin activarea Data Mapping se 

pot încărca fişiere de date .txt sau .xls care conţin valorile temperaturii distribuite 

neuniform; se aplică pe entităţi de tip muchie, faţă sau volum (fig.49). 

 (Distributed Mass) ≈ încărcare de tip masă concentrată într-un punct; se aplică pe 

entităţi de tip punct, faţă sau element virtual (fig.50). 
 

   
 

          Fig.48    Fig.49    Fig.50 
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Fig.54 
 

 (Line Mass Density) ≈ încărcare de tip densitate liniară de masă; se aplică pe o muchie 

(fig.51). 

 (Surface Mass Density) ≈ încărcare de tip densitate de masă pe suprafaţă; se aplică pe 

o faţă (fig.52). 

  
 

    Fig.51      Fig.52   
 

 Verificarea modelului cu elemente finite oferă informaţii despre: tipul de elemente finite 

existente în model; material; cosntrângerile dintre elementele componente. „Aprinderea” 

ledului verde, însoţită de mesajul de consistenţă a modelului, oferă informaţii despre 

corectitudinea întocmirii modelului cu elemente finite. Verificarea se realizează prin comanda 

 (Model Checker) ≈ verificarea modelului cu elemente finite (fig.53). 

 

 
 

Fig.53 

 

 Comenzile prezentate până în aici fac 
parte din etapa preprocesării. Rezolvarea 
modelului se realizează automat, de către 

soft, prin comanda 

 (Compute) ≈ rezolvarea modelului cu 

elemente finite; oferă informaţii despre 

estimarea resurselor hardware necesare 

rezolvării modelului (fig.54). 



Elemente introductive privind modelarea cu elemente finite utilizând soft-ul CATIA 31 

 

 

Fig.55 

 Etapa postprocesării presupune, înaintea optimizării, vizualizarea rezultatelor. 

Principalele comenzi utilizate pentru vizualizarea rezultatelor sunt prezentate în continuare. 

 (Deformation) ≈ vizualizarea stării deformate a 

modelului; prin dublu click pe specificaţia Deformed 

Mesh din arborele de specificaţii se pot vizualiza diferite 

seturi de zone deformate ale modelului; prin click-

dreapta pe specificaţia Deformed Mesh şi alegerea 

opţiunii Report, se generează un fişier .html cu rezultate; 

în cazul analizei frecvenţelor proprii de vibraţie, prin 

dublu click pe specificaţia Deformed Mesh din arborele 

de specificaţii se pot vizualiza şi stările deformate ale 

modelului pentru diferite frecvenţe proprii ale acestuia 
(fig.55). 

 (Stress Von Misses) ≈ vizualizarea câmpurilor de 

tensiuni Von Mises. Prin parcurgerea succesiuni de 

comezi View ⇒ Render Style ⇒ Customize View... ⇒ 

se selectează specificaţia Materials, se obţine 

vizualizarea câmpurilor de tensiuni Von Mises, în 

material; valorile vizualizate au ca unitate de măsură 

N/m
2 (de ex. 1.21e+008 reprezintă 1,21·10

8
 N/m

2
 sau 

1,21·10
2
 MPa unde 1 MPa = 1 N/mm

2) (fig.56). 

 Tensiunile echivalente von Mises se detremină cu 
teoria de rupere a energiei de deformaţie maxime; astfel, 

tensiunea echivalentă se determină cu relaţia 

 ( ) ( ) ( ) ( )222222 6
2

1
xzyzxyxzzyyxe

τ+τ+τ+σ−σ+σ−σ+σ−σ=σ .    (1) 

 În relaţia (1), σ reprezintă tensiunile normale, iar τ tensiunile tangenţiale (fig.57). 

 

        
 

    Fig.56      Fig.57   
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 (Displacements) ≈ vizualizarea deplasărilor. Prin parcurgerea succesiuni de comezi: 

Click pe imaginea deplasărilor sub formă vectorială ⇒ Translational displacement vector 

object ⇒ Definition ⇒ Visu ⇒ se selectează specificaţia AVERAGE-ISO şi se obţine 

vizualizarea câmpurilor de deplasări (fig.58). 

 (Principal Stress) ≈ vizualizarea tensiunilor principale. Prin parcurgerea succesiuni de 

comezi: Click pe imaginea deplasărilor sub formă vectorială ⇒ Tensor for maximum stress 

object ⇒ Definition ⇒ Visu ⇒ se poate alege vizualizarea diferitelor tipuri de tensiuni 

(fig.59). 

  
 

    Fig.58      Fig.59   

 (Animate) ≈ vizualizarea stării animate (fig.60). 

 (Cut Plane Analysis) ≈ vizualizarea secţiunii (fig.61). 

 (Deformation Scale Factor) ≈ setarea factorului de deformare (fig.62). 

     
 

   Fig.60          Fig.61         Fig.62 

 (Search Image Extrema) ≈ vizualizarea zonelor cu valori maxime pentru tensiuni sau 

deplasări. 

 (Informations) ≈ vizualizarea informaţiilor referitoare la modelul cu elemente finite. 


